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General Information

MagCat provides a method of cataloging all of the magazine articles, books, files, and other 
pieces of information lying about in a form that allows fast searching for information based 
on keywords.

Information kept about articles includes the article name, its location, a short description 
about the article, and a list of keywords used to search for the article.

A database is created to contain all of the information about the articles. This database is 
accessed via three windows. The Article window displays all of the articles in the database. It
can display the locations, keywords, and descriptions of each article and allows searching. 
The Location window displays all of the unique locations where articles are stored along with
how many articles are stored in each location. The Keyword window displays all of the 
keywords and the number of times each keyword has been used.

Multiple databases may be open at the same time to allow easy viewing of different 
databases.

Articles may be imported and exported from other databases. The entire database or just 
the results of a search may be printed.

Searches are performed using the Article window. Articles may be searched by locations and 
keywords. All articles that match the search criteria are displayed in the article window. Their
locations and descriptions may be displayed to help determine which articles are the most 
appropriate.

Help is available in the following ways:

- Use the Help menu to select help on various topics
- Most dialog boxes contain a Help button
- Pressing Shift-F1 changes the cursor to a Help pointer. The next object that you 

click on will display help on that object.



Registration

This program is being distributed as shareware. If you make use of this software you are 
expected to pay a registration fee of $30.00 to:

JDS Systems
PO Box 997
Mt. Laurel, NJ    08054-0997

Registration entitles you to a disk with the current version of the software, a registration 
number good for all 1.xx versions, a printed manual, and notice of updates to the software. 
Future versions of this software are available to registered users at a significant discount.

We can be reached with electronic mail via:

CIS 70406,415
BIX JDAGOSTINO
GENIE J.DAGOSTINO2
America Online JDSSYS

For more information about the shareware concept, terms, or an order form that may be 
printed, select one of the following.

About Shareware
Disclaimer - Agreement
Order Form



DEFINITION OF SHAREWARE

Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy. And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.



DISCLAIMER - AGREEMENT

Users of MagCat must accept this disclaimer of warranty: "MagCat is supplied as is. The 
author disclaims all warranties, expressed or implied, including, without limitation, the 
warranties of merchantability and of fitness for any purpose. The author assumes no liability 
for damages, direct or consequential, which may result from the use of MagCat." MagCat is
a "shareware program" and is provided at no charge to the user for evaluation. Feel free to 
share it with your friends, but please do not give it away altered or as part of another 
system. The essence of "user-supported" software is to provide personal computer users 
with quality software without high prices, and yet to provide incentive for programmers to 
continue to develop new products. If you find this program useful and find that you are using
MagCat and continue to use MagCat after a reasonable trial period, you must make a 
registration payment of $30.00 to JDS Systems. The $30.00 registration fee will license 
one copy for use on any one computer at any one time. You must treat this software just like 
a book. An example is that this software may be used by any number of people and may be 
freely moved from one computer location to another, so long as there is no possibility of it 
being used at one location while it's being used at another. Just as a book cannot be read by 
two different persons at the same time.

Commercial users of MagCat must register and pay for their copies of MagCat within 30 
days of first use or their license is withdrawn. Site-License arrangements may be made by 
contacting JDS Systems.

Anyone distributing MagCat for any kind of remuneration must first contact JDS Systems 
at the address below for authorization. This authorization will be automatically granted to 
distributors recognized by the Association of Shareware Professionals as adhering to its 
guidelines for shareware distributors, and such distributors may begin offering MagCat 
immediately (However, JDS Systems must still be advised so that the distributor can be 
kept up-to-date with the latest version of MagCat). You are encouraged to pass a copy of 
MagCat along to your friends for evaluation. Please encourage them to register their copy if
they find that they can use it. All registered users will receive a copy of the latest version of 
the MagCat system.



Order Form

This order form may be printed by selecting Print Topic from the File menu.

Upon receipt of your registration fee you will receive a registration number and a printed 
manual. You will also receive a disk with the current version of the software. Registered users
will also receive notices of updates and will be able to upgrade to future versions at a 
significant discount. Site licenses are also available. Contact us for details.

Name _______________________________________________

Address _______________________________________________

_______________________________________________

 _______________________________________________

_______________________________________________

Phone _______________________________________________

Qty Unit Price  Total

______ MagCat Version 1.3  $30.00 ________

______ Upgrade to latest 1.xx version  $10.00 ________
(only if you are a registered user)

(New Jersey residents include current sales tax) ________

Total ________

Disk Size 5 1/4    (1.2M)    ______3 1/2    (720K)    ______

Please make check or money order payable to JDS Systems.

Mail completed order form and check or money order (US funds only) to:

JDS Systems
PO Box 997
Mt. Laurel, NJ    08054-0997

Where did you obtain this version?    _______________________________

We would like to hear your comments on ways we can improve the program.
Comments _______________________________________________

 _______________________________________________



Commands

MagCat Window
Article Window
Keyword Window
Location Window



MagCat Window Commands

File
New
Open
Exit

Edit
Preferences

Help
Contents
Keyboard
Commands
Procedures
How to Use Help
About MagCat



Article Window Commands

File
New
Open
Close
Import
Export
Page Setup
Print
Exit

Edit
Copy
Select All
Add Article
Edit Article
Delete Article
Get Info
Preferences

Search
New
Narrow
Display All

View
Locations
Keywords
Descriptions

Window
Tile
Cascade
Arrange Icons
Close All

Help
Contents
Keyboard
Commands
Procedures
How to Use Help
About MagCat



Keyword Window Commands

File
New
Open
Close
Page Setup
Print
Exit

Edit
Copy
Select All
Get Info
Preferences

Sort
By Keword
By Usage

Window
Tile
Cascade
Arrange Icons
Close All

Help
Contents
Keyboard
Commands
Procedures
How to Use Help
About MagCat



Location Window Commands

File
New
Open
Close
Page Setup
Print
Exit

Edit
Copy
Select All
Get Info
Preferences

Sort
By Location
By Usage

Window
Tile
Cascade
Arrange Icons
Close All

Help
Contents
Keyboard
Commands
Procedures
How to Use Help
About MagCat



Title Bar

The horizontal bar located at the top of a window and containing the title of the window. On 
many windows, the title bar also contains the Control-menu box and Maximize and Minimize 
buttons.



Window Size Box

Located at the lower-right corner of each window whenever both horizontal and vertical 
scroll bars are present. Double-click this box to enlarge a window. If the window is fully 
enlarged, double-click this box to restore the window to its previous size. When the window 
border is visible, you can drag the size box to size the window horizontally and vertically.



Minimize Button

The small box containing a Down arrow at the right of the title bar. Mouse users can click the
Minimize button to shrink a window to an icon. Other users can use the Minimize command 
on the Control menu.



Maximize Button

The small box containing an Up arrow at the right of the title bar. Mouse users can click the 
Maximize button to enlarge a window to its maximum size. Other users can use the 
Maximize command on the Control menu.



Application Control Menu

Application Control Menu Commands affect application windows.

Close Closes a window.
Maximize Expands a window to the full size of the screen.
Minimize Shrinks a window to an icon.
Move Reposition the window.
Restore Returns the window to its previous size.
Size Change the size of a window.



Window Border

Borders appear on windows that are not enlarged to maximum size. You can drag a window's
border to make the window larger or smaller.
· Drag top, bottom, or side border to size in one direction only.
· Drag a corner of the border to size both vertically and horizontally.



Menu Bar

The area at the top of the primary window that contains keywords that give users access to 
actions available in that window. After users select a choice in the menu bar, the menu 
appears.



MagCat Window

This window contains the windows which display the databases. These windows are movable
and sizable only within the borders of this window.



Horizontal Scroll Bar

The Scroll bar located at the bottom edge of the database windows. The scroll box inside the
scroll bar indicates your location in the database horizontally. You can use the mouse or 
cursor keys to scroll to other parts of the document.



Vertical Scroll Bar

The Scroll bar located at the right edge of the database windows. The scroll box inside the 
scroll bar indicates your location in the database vertically. You can use the mouse or cursor 
keys to scroll to other parts of the document.



New

The New command creates a database. A dialog box allows the name and location to be 
specified.



Open

Opens an existing database. A dialog box allows the database to be selected.



Close

Closes the current database. All changes made to the database are saved.



Page Setup

The Page Setup dialog allows the margins to be specified for printing.



Print

The Print Dialog allows you to select the various print options to print the data in the current 
window.



Exit

Closes any open databases and exits from MagCat.



Tile

A way of arranging open windows so that no windows overlap but all windows are visible. 
Each window takes up a portion of the screen.



Cascade

A way of arranging open windows so that they overlap each other, with the title bar of each 
window remaining visible.



Arrange Icons

Aligns any minimized windows along the bottom of the MagCat window.



Close All

Closes all open windows and databases.



About Box

Displays a dialog box showing the MagCat version number and copyright notice.



Get Info

This command displays a dialog box showing the number of articles, keywords, and locations
in this database.



Preferences

Displays a dialog box with the current defaults used when windows are opened.



Keyword Copy

Copies the selected keywords and their counts to the clipboard.



Select All Keywords

Selects all the keywords in the database.



Sort Keywords By Name

This command displays keywords in alphanumeric order.



Sort Keywords By Usage

This command displays the keywords in order of usage. The least often used keywords are 
displayed at the top of the list and the most often used keywords are at the bottom.



Keywords Window

This windows displays all of the keywords used by articles in the database along with the 
number of times they are used. This list may be viewed in either alphabetical or usage order.



Copy Locations

Copies the selected locations and their counts to the clipboard.



Select All Locations

Selects all the locations in the database.



Sort Locations By Name

This command displays locations in alphanumeric order.



Sort Locations By Usage

This command displays the locations in order of usage. The least often used locations are 
displayed at the top of the list and the most often used locations are at the bottom.



Locations Window

This windows displays all of the locations used by the articles in the database.



Import

This command allows adding articles from other sources to the database. A dialog box allows
selecting the file to import.

The import file must be a tab-delimited file.



Export

This command extracts the articles from the database into a text file for use in another 
program.



Copy Articles

Copies the selected articles to the clipboard. The amount of information copied to the 
clipboard depends on which View options are enabled. If the Locations are displayed, the 
Article Name and Location will be copied. The same applies to the Keywords and 
Descriptions.



Select All Articles

Selects all the articles in the database.



Add Article

Displays a dialog box which allows the information about an article to be entered.



Edit Article

Allows the information about the selected article to be changed.



Delete Article

Deletes the selected articles.



New Search

Starts a new search for articles. A dialog box allows specifying the keywords and locations 
for the search.



Narrow Search

Refines a previous search when more articles where found than expected.



Display All

Displays all of the articles in the database.



View Descriptions

This command displays the descriptions stored with each article.



View Keywords

This command displays the keywords stored with each article.



View Locations

This command displays the locations stored with each article.



Articles Window

This window displays the articles in the database and allows adding, editing, deleting, and 
searching for articles.



Preferences Dialog

This dialog box allows the defaults to be specified.

Article Window
Default View These options allow you to select whether the Locations, 

Keywords, and/or the Descriptions are displayed when a 
database is opened.

Maximize on Open Determines whether the Article window should be displayed as 
large as possible when a database is opened.

Keyword Window
Default Sort Defines how the window should be sorted when a database is 

opened.
Minimize on Open Determines whether the window should be opened as an icon.

General
Initial Window Placement Determines how the windows should be placed when a 

database is opened.
Maximize on Open Determines whether the main MagCat window should be 

opened as large as possible when the application is started.
Remember Settings This cause MagCat to remember all databases and window 

positions that are open when Exit is selected. The next time 
MagCat is run, these databases will be automatically opened 
and the windows re-positioned.

Location Window
Default Sort Defines how the window should be sorted when a database is 

opened.
Minimize on Open Determines whether the window should be opened as an icon.

OK Selecting OK will save your changes so that they can be used 
the next time the application is started and a database is 
created or opened.

Cancel Selecting Cancel will ignore any changes and continue to use 
the previous selections.



File Create Dialog

This dialog allows the filename for new database to be specified.



File Open Dialog

This dialog allows an existing database to be opened.



Export Dialog

This dialog specifies the file to store the exported data.

If the Only Selected box is checked, then only the entries selected will be exported.



Import Dialog

This dialog selects the file which contains the data to be imported.



Add/Edit Article Dialog

This dialog allows an article to be added to the database or the information about an article 
to be changed.

Descriptions:
Article Name This is the name of the Article.

Location This the name of the location where the article may be found.

Month This is month of the issue. The combo box contains most of the 
common names that periodicals use. If there is no month, select
"None".

Day This is the day of the month. Set to 0 if this is not required.

Year This is the year. Set to 0 if this is not required.

Volume Major This is the major volume number. Set to 0 if this is not required.

Volume Minor This is the minor volume number. Set to 0 if this is not required.

Page This is the page number of the article.

Keyword List This is a list of keywords that may be used to find the article. A 
keyword is added be typing it in the edit field and clicking Add. 
A keyword may be removed by selecting it from the list and 
clicking Remove. The keywords may contain spaces. A useful 
keyword to add is the authors name to allow searching for 
articles by a particular author.

Add Used to Add the keyword in the edit field.

Remove Used to remove the keyword selected in the Keyword List.

Description A short abstract of the article.

OK Selecting OK will add the entry into the database.

Cancel Selecting Cancel will lose all of your changes.



Search Dialog

This dialog allows specifying the search criteria. A message will appear at the bottom of the 
dialog box indicating what field may be in error.

Descriptions:
Location Where an article resides. If the Location ends in an asterisk, a 

wildcard search will be performed. All locations matching the 
initial letters before the asterisk will be selected. If this field is 
left blank, then the keywords will be used to select the articles 
for every location. If the field contains an entry, then only 
articles matching this location will be selected using the 
keywords.

Month The month to be used in the search. Or "Any" may be selected 
to wildcard this field.

Day The day to be used in the search. Or an asterick may be used to
wildcard this field.

Year The year to be used in the search. Or an asterick may be used 
to wildcard this field.

Volume Major The major volume number to be used in the search. Or an 
asterick may be used to wildcard this field.

Volume Minor The minor volume number to be used in the search. Or an 
asterick may be used to wildcard this field.

Keywords These fields are used to specify the words to use to search for 
the article. If the "And" between a pair of keywords is selected, 
the article must contain each keyword. Selecting "Or" requires 
the article to contain either keyword. An asterisk can be used as
a wildcard character to match all keywords containing the first 
letters of this keyword.

OK Selecting OK will perform the search. If no entries are found, a 
dialog box will appear to alert you that no articles match the 
search criteria. Otherwise, only the matching entries will appear
in the article window.

Cancel Select Cancel will abort the search.



Page Setup Dialog

The Page Setup dialog specifies the margins to be used to print the database.



Print Dialog

The Print dialog allows you to specify what to print. What to print is dependent on which 
window was on top when print was selected.

Keywords Window
The keywords and their counts will be printed.

Locations Window
The Locations and their counts will be printed.

Articles Window
The Articles will be printed. If any of the View options are selected, then that 
additional information will be printed along with each article.

If the Only Selected box is checked, then only the entries selected will be printed.



Keyboard

The following keyboard topics describe the keyboard shortcuts available in MagCat. Choose 
from the following list to review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function
DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function
TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter 

matches the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes 
the command.

ESC Closes a dialog box without completing the command. 
(Same as Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function
BACKSPACE Deletes the character to the left of the cursor.

Or delete selected text.
DEL Deletes the character to the right of the cursor.

Or delete selected text.
CTRL+INS or CTRL+C Copy the selected text and place it onto the Clipboard.
SHIFT+DEL or CTRL+X Delete the selected text and place it onto the Clipboard.
SHIFT+INS or CTRL+V Paste text from the Clipboard into the active window.
ALT+BACKSPACE or CTRL+Z Undo the last editing action.



Help Keys

Key(s) Function
F1 Gets Help and displays the Help Index for the 

application. If the Help window is already open, pressing 
F1 displays the "Using Windows Help" topics.

SHIFT+F1 Changes the pointer to  so you can get Help on a 
specific command, screen region, or key. You can then 
choose a command, click the screen region, or press a 
key or key combination you want to know more about.



Menu Keys

Key(s) Function
Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined 

letter matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches 

the one you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function
Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized 

icon, including full-screen programs.
Alt+TAB Switches to the next application window, restoring 

applications that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the 

application. (See Help Keys)



Text Selection Keys

Key(s) Function
SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left or right.
SHIFT+DOWN or UP ARROW Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is already 
selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous window is 
already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the previous or next word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or end 

(DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function
ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Quit Windows.
Alt+Esc Switches to the next application window or minimized 

icon, including full-screen programs.
Alt+TAB Switches to the next application window, restoring 

applications that are running as icons.
Alt+ENTER Switches a non-Windows application between running in 

a window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the 

Control menu.
Or, changes the size of a window when you have chosen 
Size from the Control menu.

SHIFT+F4 Arrange the open windows side by side ("tile" them).
SHIFT+F5 Arrange the open windows so that each title bar is 

diaplayed ("cascade" them).
CTRL+F4 Close the active database windows.



Defined Terms

Article
Database
Description
Keyword
Location



Article

An Article is the description of the document. It consists of the name of the article, its 
Location, up to 100 Keywords used to index it, and a Description. 



Database

The Database contains the information and indexes for the articles.



Description

The Description is a short abstract of the article or your own notes of what was important 
about this article. This is to give you some idea of which articles are the most appropriate 
when a list of several articles appear after a search.



Keyword

A Keyword is a short word or phrase used to identify an article. It can be a company name, 
product name, or any phrase that would help to classify an article.

Keywords can be up to 63 characters in length and may contain spaces or other special 
characters.



Location

A Location defines where an article may be found. It is primarily designed for designating 
magazines, but it can also be used to indicate a file in a filing cabinet, a book, or even a CD-
ROM. The location consists of a name field, which may be the name of the magazine, and 
optional date and volume fields.



Procedures

Starting MagCat
Creating a Database
Opening a Database
Adding an Article
Editing an Article
Deleting an Article
Searching for Articles
Importing Articles from other Sources
Exporting Articles
Printing a Database
Viewing Keywords
Viewing Articles
Viewing Locations
Setting Preferences



Starting MagCat

MagCat is normally started by double-clicking on its icon in the program manager. There are 
several ways to open a database with MagCat. The normal method of using the file menu is 
described in the following chapter. Other methods are:

1) Drag and Drop - Dragging one or more icons of databases over a MagCat window will 
cause the databases to opened. This feature is only supported if the SHELL.DLL file is 
present. This file is included in Windows 3.1.

2) Any databases specified on the command line passed to MagCat when it is run will be
automatically opened.

3) The most powerful method is to check Remember Settings in the preferences 
dialog. This causes MagCat to remember to databases and window positions that are 
open when Exit is selected. These databases will then be opened and the windows 
re-positioned the next time MagCat is run.



Creating a Database

To create a new database, select New from the File menu. The dialog box allows you to type 
the name of the database and to select the directory where the database should be stored. 
Selecting OK will create the database file and windows to allow it to be manipulated.



Opening a Database

To open a database, select Open from the File menu. The dialog box allows you to select the 
directory and database from the list boxes. Selecting OK will open the database and display 
it in the windows.



Adding an Article

An article may be added to a database following these steps:

1) Open the database if not already open
2) Select the Article window if not already selected
3) Select Add Article from the Edit menu
4) Fill out the entries in the dialog box
5) Select OK

An article must have a name, location, and at least one keyword to be added to the 
database. An optional description can also be included.

If you would like to add an author to an article entry, simply add it as a keyword. If there are 
several authors for an article, add them as separate keywords. This allows easy searching 
for articles by a particular author.



Editing an Article

An article may be edited to change anything about it by selecting the article in the Article 
window and then selecting Edit from the Edit menu. You can also double-click on an article to
quickly bring up the Edit dialog box.



Deleting an Article

An article may be deleted from a database by selecting the article in the Article window and 
then selecting Delete from the Edit menu. A dialog box will prompt you to allow you to 
cancel this action. Multiple articles may be deleted by selecting all of the articles to be 
deleted and then selecting Delete. As each article is deleted, you will be prompted to 
confirm the operation.



Searching for Articles

You can search for an article of interest by using the Search menu on the Article window. 
Selecting New from the Search menu allows you to enter a location and/or keywords to 
search. Locations are always ANDed with the result of any keyword search. Multiple 
keywords may be specified to restrict the search. All articles which meet the search criteria 
are displayed in the Article window. If you wish to refine the search terms, select Narrow 
from the Search menu to add or change the criteria used for the search. Any changes will be
applied to the entire database, not just the result of the previous search. To restore the 
Article window to display the entire database, select Display All from the Search menu. All 
entries in the database will be displayed.



Importing Articles from other Sources

To import data from other databases, select Import from the File menu of the Article window. 
The dialog box will allow you to select the file containing the data. Clicking OK will add the 
records to the database.



Exporting Articles

To export articles to a tab-delimited file for use in other applications, select Export from the 
File menu of the Article window. The dialog box allows you to enter the name of the file to 
receive the data.



Printing a Database

To print a database, first decide what information you wish to print. The Print command 
prints the data in whichever window is active. The following describes how the information 
for each window is printed.

Article Window
The articles along with whatever view information displayed are printed. If the display 
contains the results of a search, then only the search results are printed. If "Only 
Selected" is checked, then only the items selected are printed.

Keyword Window
The keywords along with the usage counts are printed in the order they are displayed. If 
"Only Selected" is checked, then only the items selected are printed.

Location Window
The locations along with the usage counts are printed in the order they are displayed. If 
"Only Selected" is checked, then only the items selected are printed.



Viewing Keywords

All of the keywords used by articles in the database may be viewed in the Keywords window. 
This window displays every unique keyword and the number of articles which contain the 
keyword. The keywords may be displayed sorted by name or by usage.



Viewing Articles

Article are displayed in the Article window. By default, all articles in the database are 
displayed sorted by article name. If a search is used, only articles that match the search 
criteria are displayed. More information stored with the articles may be displayed. If the View
Locations option is checked, the location where the article is stored is displayed. If the View 
Keywords option is checked, the keywords for the article are displayed. If the View 
Descriptions option is checked, the description is displayed.



Viewing Locations

The Locations where the articles in the database are stored may be viewed in the Locations 
window. This window displays every unique location and the number of articles stored there. 
The locations may be displayed sorted by name or by usage.



Setting Preferences

The Preferences command allows the defaults that are used when a database is created or 
opened to be changed.


